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Delaware Coastal Communities Impervious Surface Coverage

Background:
Through
its
Resilient
Community
Partnership program, the DNREC Delaware
Coastal Programs (DCP) is providing
technical assistance to the City of
Rehoboth Beach, the City of Lewes, Town
of Henlopen Acres, Town of Dewey Beach,
Town of Bethany Beach, Town of South
Bethany and the Town of Fenwick Island
(Figure 1) in order to conduct an
assessment of impervious surface
coverage due to increased development in
their communities, and its corresponding
impacts on stormwater management,
flooding, and water quality both in present
and future climate conditions. The project
will additionally provide options for
slowing the rate of increase of impervious
surface coverage in future development,
including the development of model
ordinances to reduce rate of increase of
impervious surface coverage amounts,
nature based solutions to increase
stormwater infiltration, and/or other
options such as establishing in-lieu fees.
Guidance will also be provided to each
municipality seeking to tailor and
implement the model ordinances in their
areas.

Figure 1. Delaware Coastal Municipalities

To facilitate this process, the current (2016) and historic (2007) amounts of impervious surface in
these communities needs be determined. The State of Delaware has impervious surface GIS layer
for 2007 and the Chesapeake Conservancy produced a more recent land cover dataset (2016) using
2013 and 2014 NAIP and orthoimagery. However the accuracy of the data has not been validated
in high density coastal communities. To correctly project trends in increasing impervious surface
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area, an accuracy assessment of the data needs to be performed to define the range of potential
errors in any prediction. In addition, some areas of impervious surface are inevitable; these include
roads and other public infrastructure. To estimate the potential impact of any new ordinances,
these non-affected regions must be separated out.
Objectives:
The project objectives were to:
1) assess the accuracy of the impervious GIS layer in 2007 and 2016 for the Delaware coastal
communities of the Cities of Rehoboth Beach and Lewes, and the Towns of Henlopen Acres,
Dewey Beach, Bethany Beach, South Bethany and Fenwick Island, and to
2) determine the change in impervious surface cover from 2007 to 2016.
Data:
Download impervious surface GIS layers for 2007 and 2016
2007 Delaware impervious surface layer (referred to as Delaware layer)
This layer was provided by Dr. Robert Scarborough as zip file (ssz_east_impervious.zip), and
uncompressed as raster layer (ArcInfo GRID format). The layer is also available through ArcGIS Pro
All Portal at:
(http://firstmap.gis.delaware.gov/arcgis/services/PlanningCadastre/DE_ImperviousSurface_Sussex
East_2007/ImageServer).
Raster layer contains pixels values of;
0
background
1
pervious
2
impervious
2016 Chesapeake Conservancy impervious surface layer (referred to as Chesapeake layer)
Sussex County Delaware layer was downloaded from web at:
https://chesapeakeconservancy.org/conservation-innovation-center/high-resolution-data/landcover-data-project/ as compressed zip file. Uncompressed file was in an Imagine (img) image format,
and exported to file geodatabase for processing. User’s manual indicates that 2013 and 2014 NAIP
and orthoimagery along with other data were used to create this dataset. Dataset also available
through image service at:
https://firstmap.delaware.gov/arcgis/rest/services/DE_Imagery/DE_Imagery_Sandy/ImageServer.
Raster layer pixel values shown in Table below.
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The sections that follow describe the detailed processing of the data layers with the results discussed
within each section.
Accuracy Assessment Preprocessing
The following step describe the processing tasks performed to complete the accuracy assessment of
both the Delaware and Chesapeake layers:
1) Delaware and Chesapeake layers projected to Delaware State Plane, NAD83, meters
using Project Raster tool and output as file geodatabase raster layers.
2) Generated point features to assess the accuracy of both layers. A stratified random
sampling scheme was selected to ensure evenness of geographic coverage, but to
also contain a random component for urban areas periodicity. This was a two-step
process.
a. Create a stratified sampling grid of square cells called a fishnet across study
area encompassing the beach communities. Our objective was to create a
fishnet fine enough to capture the spatial variation in land cover, while also
keeping in mind the effort involved in checking each point. A grid with 300 by
300 meter grid cells resulted in 262 grid cells, or 262 sampling points to check.
The Create Fishnet tool specifying cell size of 300 by 300 meters and geometry
type polygon created the fishnet.
b. Select a random point within each grid cell of the fishnet using the Create
Random Points tool (specifying number points to 1) to create point features to
assess accuracy of the Delaware and Chesapeake layers.
Figure 2 displays the stratified sampling with an accuracy assessment point
within each grid cell displayed in red.
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Figure 2. Stratified random sampling scheme used to select
assessment points.

3) The next step entailed subsetting the Fishnet Random Points layer to extract only the
random points falling within the Delaware Beach Municipalities of City of Rehoboth
Beach, the City of Lewes, Town of Henlopen Acres, Town of Dewey Beach, Town of
Bethany Beach, Town of South Bethany and the Town of Fenwick Island. This was
accomplished using the Clip tool (Figure 3).
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Figure 3. Sampling points clipped to beach towns.
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4) Assign the Delaware and Chesapeake raster layers’ land cover to each assessment point
in point feature class using the Extract Values to Points tool. This tool extracts the land
cover information (raster cell values) geographically overlaying each fishnet random
point and records the values in the assessment point feature class attribute table.
Figure 4 displays point feature class (layer) and it attribute table. One assessment point
selected in blue shows the land cover is impervious. This point layer is the layer used
for the accuracy assessment (AccuracyAssessmentPoints)

Figure 4. Zoomed in view displaying the accuracy assessment points for Henlopen
Acres and Rehoboth Beach.

5) The last step consisted of creating news fields to specify if the land cover surfaces
were accurate at the sample points and to make notes about the type of surface if
incorrect or difficult to determine. The important fields in the point layer include:
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Attribute Table Field
RASTERVALU
coding_system

comments
ChesapeakeData
ChesapeakeComments

Description
Delaware layer raster pixel value
Delaware layer raster accuracy code
0 unknown
1 for accurate
2 for not accurate,
3 out of bounds of data layer (background)
Delaware raster accuracy notes
Chesapeake layer raster pixel value
<same as Delaware layer>
Chesapeake raster accuracy notes

The Chesapeake layer does not extend into the ocean, while the Delaware layer does
extends into the ocean (e.g., Lewes). For all those points coded 0 originally, we went
back through, evaluated again and assigned an accuracy.
Accuracy Assessment Process
To perform the accuracy assessment, Google Earth and Google Street View were used to visually
check each sample point. The process started in ArcGIS Pro by right clicking on a point and selecting
Copy Coordinates to get the X,Y coordinates of the point. Then in Google Earth Pro, these X,Y
coordinates were pasted into the Search window to navigate to the exact location.
The Google Earth Historical Imagery slider (tool found under the View menu) was used to select the
2007 imagery for the Delaware layer. For the Chesapeake layer, we toggled between 2015, 2017,
and 2018. Additional imagery for 2009 and 2011 were found, but at a reduced spatial resolution.
The Zoom In/Out slider tool was invaluable to zoom to the appropriate scale to determine if the
location was impervious or pervious.
At times, the surface was difficult to see because of tree cover, or if it was too close to the boundary
between a concrete and grassy area. In cases where we were unsure, we toggled between Google
Earth Aerial View and Google Earth Street View, and used the time series of imagery available to see
if a structure existed before or after the layer’s date to see what kind of surface was present at any
given location and time. Street View was helpful occasionally when attempting to see more detail.
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As one example, in some locations the Google Earth Aerial View (Figure 6 right panel) was not
always clear enough to see if a driveway was gravel or concrete. When using Street View (Figure 6
left panel), viewing the surface from a different angle enabled the surface to be identified. However,
Street View was not helpful to identify areas not visible from a street, such as backyards.
The
most

Figure 5. Google Earth Street View (left) and Aerial View (right)

troubling surfaces were dark gravel driveways that appeared to be rather impervious with no ground
showing through and possibly an asphalt slury mix (Figure 6). In most cases, using Google Earth and
Google Street View were effective in determining if a surface was impervious or pervious, and
allowed us to make a comment in the attribute table about exactly what type of surface was present
at each point.
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Figure 6. Example of surfaces difficult to assess

Each point was evaluated twice, once by an undergraduate student followed by the Principal
Investigator.
The accuracy assessment field for both layers were then summarized to determine the accuracy
using the Statistics tool (right click on Delaware layer coding_system field and ChesapeakeData field
for Conservancy layer).
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Accuracy Assessment Results
Of the 262 assessment points, 2 were discarded for the Delaware layer within the background area
and 32 discarded for Chesapeake layer. The larger number for the Chesapeake layer was because
this layer’s eastern edge border stopped at the ocean’s water edge. The Delaware layer is 93.5%
accurate and the 92.2% for the Chesapeake layer.
The breakdown of sample points assessed is displayed below, along with maps of the assessment
points shown in Appendix 1 (accurate – green points, inaccurate – red points).
Delaware layer
93.46%
Chesapeake layer
92.17%

243 accurate (of 260 points)
17 not accurate
2 background (not used in accuracy calculation)
212 accurate (of 230)
18 not accurate
32 background

Total Impervious Cover Area by Municipality Processing
To compute the total area of impervious cover for each beach town (municipality) for both layers,
two steps were completed.
1) The first step entailed reclassifying the Delaware and Chesapeake layers using the
Reclassify tool so that the impervious surface pixel values equaled 1 and all others pixel
values set to NODATA.
2) The second step used the Zonal Statistics By Table tool to sum the number of pixels with
value of 1 (impervious). This count of pixels was then multiplied by the cell size of each
pixel, which in this case was 1 meter by 1 meter, and converted to square kilometers.
The screen shots below display both the tools and their options specified.
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Municipality Impervious Surface Results
The table (ImpSfcResults.xlsx) below summarizes the total municipality area (km2), and the total
area of impervious surface (Imp Sfc) (also the pixel count), percent of impervious surface, and
change over the 10 year period (2016 - 2007) for each municipality.

Municipality

Town
Area1

2007 Delaware Layer
Imp Sfc
Area1

Bethany Beach
3.05
1.14
Dewey Beach
1.16
0.53
Fenwick Island
1.30
0.41
Henlopen Acres
0.67
0.15
Lewes
11.94
2.12
Rehoboth Beach
3.90
1.35
South Bethany
1.37
0.48
1
square kilometers
2
2016 Chesapeake - 2007 Delaware

% Imp
Sfc
37.39
45.18
31.45
22.83
17.74
34.44
35.27

2016 Chesapeake
Layer
Imp Sfc
Area1

% Imp
Sfc

Imp Sfc
Area
Change1,2

1.29
0.53
0.48
0.16
2.32
1.35
0.59

42.22
45.13
37.10
24.39
19.41
34.70
42.97

0.15
0.00
0.07
0.01
0.20
0.01
0.11

% Imp
Sfc
Area
Change
4.83
-0.05
5.66
1.56
1.67
0.25
7.71

Dewey Beach has the highest percent of impervious surfaces at 45% for 2007 and a very slight
decrease by 2016. Lewes has the lowest percent of impervious surface area at 17.4% in 2007 with
an increase to 19.4% by 2016. The beach municipality with the greatest increase in impervious
surfaces over the 10 year period was South Bethany at 7.7% increase. Bethany Beach and Fenwick
Island also saw increases in impervious surfaces of 4.8% and 5.7% respectively from 2007 to 2016.
Non-Public Impervious Surface Area Processing
The private land areas were separated from public designated land (streets, parking areas, etc.)
using Sussex County Parcel data obtained from Sussex County Mapping and Addressing
Department. This was accomplished following the processing steps below. Careful notes are
provided due to the complexity of the parcel data associated with parcel boundaries extending
across two or more towns, Town Code not matching the municipality resides within, Land Code
= MX includes both private and public land, and parcels containing attributes with nulls.
Parcel layer contains 146,493 polygons
Parcels layer contains 26 parcels (rows) with TaxID equal to <New parcel>, 0, or 1. Also, 51
parcels with Shape_Area less than 25 m2.
TaxID is not spatially unique. The same TaxID may be associated with multiple parcels,
however each parcel is spatially distinct, not overlaying.
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One parcel may cross into multiple towns as shown in the three figures below.

Parcel Land Code
14

= MX (Miscellaneous) with Town Code = BB (Bethany Beach), but located within South
Bethany geographic area.

The steps below describe the processing tasks to compute the total private impervious surface area
for each town.
1. Join Ownership table to Parcels layer using
common identifier TaxID (Add Join tool). Export
to new feature class (Parcel_wOwnership) by
right clicking on the layer and select Data >
Export Features. Remove all Joins by right
clicking on layer, select Joins and Relates >
Remove All Joins. (198,828 polygons)
This keeps all parcels in the input layer.
Some TaxIDs associated with same parcel
(overlapping geographically). Example TaxID
134-13.00-101.00 – 5 overlapping parcels
with same area.
Joined layer contains parcels with Town Code = <NULL> and Land Code = <NULL>.
(1922 parcels)
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Joined layer contains parcels with Town Code = 00 (Seems to be parcels outside of
towns, but a few parcels within beach towns.
2. Intersect the Parcels_wOwnership
and Municipality layers so each
parcel is tied to the town
geographically within
(Parcel_wOwnership_Intersect).
This splits a parcel that crosses
town boundaries.
17 parcels Land Code = <Null>.
1488 parcels with Town Code =
00. Land Code has values.

3. Compute total parcel area for each
town using Dissolve tool,
aggregating on Name (town name)
(Parcels_DissolveByTown).

4. Select private parcels (Parcels_wOwnership_Intersect) using excel worksheet obtained
from Sussex County Dept (Appendix 2). Private includes all Land Codes except local,
state, and federal government and some miscellaneous. Commercial and industrial
considered private.
a. Select by Attributes all private parcels (not equal to LG, ST, and US, and specific
miscellaneous values) (PrivateLandcodeQuery.exp).
b. Export selected features to new feature class (Private) by right clicking on layer,
select Data > Export Features. (Private), (15,805 parcels)
c. Clear selection
16

Checked parcels with Land
Code = MX by Owner.
Excluded Owner with Name of
Town Of, City Of, Delaware
River &/and Bay Authority,
Delaware State of, Sussex
County.

5.

Aggregate the private parcels
with same TaxID and average
the parcels Shape_Area using
Dissolve tool so each private
parcel is spatially distinct
(Private_Dissolve). (10,648
parcels)
Example: TaxID 134-13.00113.00 has 53 parcels all
geographically same parcel with
same Shape_Area 30284 m2.
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6.

Dissolve Private_Dissolve by
Municipality (Name) to
summarize the private land area
by town (Private_
Dissolve_ByTown).

7. Compute the impervious surface (DEReclass, CHESReclass) for private land by
municipality (NAME) using Zonal Statistics by Table (DE_Private, CHES_Private).
For DEReclass and CHESReclass layers, impervious surface pixels value = 1 and all
other pixels = NODATA.
Also ran Zonal Statistics tool with Statistic type: Sum to check areal coverage of each
town.
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Zooming in to each municipality shows the individual parcels contained within the
municipality and areas like roads, canals, beaches excluded within the parcel layer. The two
images below display the City of Lewes (top) and zoomed in view (bottom) with private
(orange) and public (green) parcels visible that are bounded by the roads and a canal. Lewes’
total parcel area is 9.630 km2, while the municipality area is 11.942 km2.

19

The image below displays the town of South Bethany. South Bethany’s municipality area is
1.372 km2, while the total parcel area is 0.914 km2.
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Private Impervious Surface Area Results
The Table (PrivateImpSfcResults.xlsx) below summarizes the private parcel area (labeled Private
Area), private impervious surface area (Private Imp Sfc), and the percentage of private impervious
surface area to the total private land area (% Imp Sfc Private) in each municipality for 2007 and 2016.
The percent change in impervious surfaces over the 10 year period is shown in the last column (%
Private Change).
Municipality

Private
Area1

2007 Delaware Layer
Private % Imp Sfc
Imp
Private2
Sfc1
0.78
35.98
0.35
64.54
0.29
50.03
0.09
23.51
1.21
24.59
0.82
48.25

2016 Chesapeake Layer
Private % Imp Sfc
Imp
Private2
Sfc1
0.89
40.96
0.34
64.10
0.35
60.31
0.09
23.48
1.36
27.64
0.82
48.56

%
Private
Change4

Bethany Beach 2.18
4.98
Dewey Beach
0.54
-0.44
Fenwick Island
0.58
10.28
Henlopen Acres 0.37
-0.03
Lewes
4.90
3.05
Rehoboth
1.69
0.31
Beach
South Bethany
0.79
0.34
43.01
0.41
52.17
9.15
1
square kilometers
2
Private impervious surface area divided by total private land (%)
3
2016 Chesapeake percent private impervious surface area minus 2007 Delaware percent private
impervious surface area

In 2007, Dewey Beach has the largest percent of private impervious surface in comparison to total
private land area at 64.5%, followed by Fenwick Island (50.0%) and Rehoboth Beach (48.3%).
Henlopen Acres has the lowest percentage at 23.51% in 2007. A large increase in private impervious
surfaces occurred in Fenwick Island (10.3%) and South Bethany (9.15%) over the 10 year period.
Bethany Beach private impervious surfaces grew by nearly 5%. Dewey Beach (0.4%) and Henlopen
Acres (0.03%) private impervious surface actually decreased slightly by 2016.
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The table below summarizes the private impervious surface in comparison to the total parcel area
(excludes lakes, canals, beaches) and total town area delineated by the Municipality layer.

2.18

2007 Delaware Layer
Private % Imp
% Imp
Imp
Sfc
Sfc
1
2
Sfc
Parcel
Town3
0.78
30.79
25.70

0.54
0.58

0.35
0.29

52.92
46.99

29.64
22.43

0.34
0.35

52.56
56.64

29.44
27.04

-0.36
9.66

-0.20
4.61

0.37

0.09

17.69

13.06

0.09

17.66

13.04

-0.02

-0.02

4.90
1.69

1.21
0.82

12.52
38.34

10.10
20.90

1.36
0.82

14.07
38.59

11.35
21.03

1.55
0.25

1.25
0.14

0.79

0.34

37.09

24.71

0.41

44.98

29.97

7.89

5.26

Private
Municipality Area1
Bethany
Beach
Dewey Beach
Fenwick
Island
Henlopen
Acres
Lewes
Rehoboth
Beach
South
Bethany

2016 Chesapeake Layer
Private % Imp
% Imp
Imp
Sfc
Sfc
1
2
Sfc
Parcel
Town3
0.89
35.06
29.26

%
Private
Parcel4

%
Private
Total5

4.26

3.56

In 2007, Dewey Beach has the largest percent of private impervious surface in comparison to total
parcel area (52.92%) and town area (29.64%). Lewes has the lowest percentage of private
impervious surface to total parcel area and total town area for both years. Fenwick Island showed
the largest percentage increase in private impervious surface to total parcel area at 9.7% followed
by South Bethany (7.9%), while South Bethany showed the largest increase of 5.3% when comparing
to total town area.
Impervious Surface Maps by Municipality Processing
To spatially display the change in impervious cover from 2007 to 2016 for each town the
following processing steps were completed:
1) Reclassify the Delaware and Chesapeake layers so only impervious surface pixels
have values and other pixels set to NoData.
Delaware layer
Background (0) set to 1
Pervious (1) = 1
Impervious (2) = 2
Nodata = Nodata
Chesapeake layer (shown in tool)
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2) Combine the two reclassified layers to
determine any change. This tool combines
rasters so that a unique output value is
assigned to each unique combination of
input values (DE_Reclass2, CHES_Reclass2).

3) Subset Combine layer to only the
municipalities using Extract by Mask tool
(Combine).

Impervious Surface Maps by Municipality
The Lewes impervious surface change map is displayed below as an example. The green shaded
areas represent permeable surfaces for water to infiltrate, while the two red tones are
impervious surfaces. Dark red areas represent surfaces that have changed over the last 10 years
to impervious surfaces.
All the municipalities are included in Appendix 3.
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Figure 7. Lewes surface change map. Impervious surface change from 2007 to 2016. Green color
represents pervious surface, while red impervious surface. Dark red is change from pervious to
impervious surface.

SUMMARY
This work provides an analysis of the impervious surface area for the Delaware Beach
communities. The impervious surface information is derived from two datasets with publication
dates of 2007 and 2016.
On average, the beach towns’ impervious surface area was 32% of the town area in 2007 with an
increase to 35% by 2016. This 3% increase in impervious surfaces represented an increase in
impervious surface area of 0.96 km2. South Bethany showed the largest increase of 7.7% over
the 10 year period, while Dewey Beach had a slight decrease its impervious surface cover from
2007 to 2016.
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An analysis of only the private land areas revealed 41% private impervious surface area to total
private land, 34% to total parcel area, and 21% of total town area for 2007. On average each
town’s private impervious surface grew by 0.06 km2 and the percent change over the 10 year
period was nearly 4% to total private land, 3% to total parcel area and 2% to total town area.
In conclusion, this analysis revealed a 3% increase in impervious surface area in the Delaware
Beach Communities over the 10 year period. The private designated areas within the towns
reveals a 2% increase (in comparison to total town area) from 2007 to 2016.
As a note of caution, care must be taken in using these results given the accuracy of the two
impervious surface datasets (Delaware layer 93%, Chesapeake layer 92%) and the complexity of
the parcels data noted in the discussion above which may have contributed to errors in these
results.
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APPENDIX 1
The accuracy of each point shown in the Figures below with the upper figure displaying the Delaware
layer and the bottom figure the Chesapeake layer on each page. The green points are accurate,
while red points are not.
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Appendix 2: Parcel Layer Land Code Description
Land
Code
AG
AH
AI
AS
BC
CC
CH
CM
CO
CX
FG
FH
FI
FP
FS
IN
LG
MA
MX
N
NP
P
PK
PM
R
RA
RC
RH
RI
RM
RS
RT
RV
ST
TC
TP
TR
TX
US

Description

Private (1)

Farm
Farm W/Homesite
Farm W/Improvement
Farm W/Leased Homesite W/RES IMP
Boat Condo
Commercial Condo
Church
Campground & Boat Marina
Commercial
Condominium Exempt(land billed out to common elements w/ units)
Farm in the Farmland Assessment Act
Farm W/Homesite in the Farmland Assessment Act
Farm W/Improvement in the Farmland Assessment Act
Farmland Preservation Act
Land in Farmland Assess. Act W/Leased Homesite W/RES IMP
Industrial
Local Government (County, Town, School)
Marina
Miscellaneous
No Not Possible
Non-Profit Organization
Residential if Property has a Residential Appraisal
Trailer
Home Park W/Boat Marina
Residential
Residential, Apartment
Residential, Condominium
Residential, House No Land
Residential, IMP (I.e. Shed, Chicken)
Residential, Multiple-Duplex
Residential, Single
Residential, Trailer(on own property)
Residential, Vacant Lot
State Government
Trailer, Condominium
Trailer, Park (Trailer located in park)
Trailer, Residential (on lands of)
Same as "MX" Temporary Exempt
United States Government
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1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
2
2

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

UT
WD
RL

Utility
Woodland Program (Forestry)
Residential, house on leased land

1
1
1
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Appendix 3: Impervious Surface Cover Change from 2007 to 2016

Lewes
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Henlopen Acres (northern town) and Rehoboth Beach (southern)
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Dewey Beach
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Bethany Beach
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South Bethany
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Fenwick Island
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